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1 Introduction to the Administration Guide
PLA 3.0 is your software for biostatistical analysis in R&D and regulated environments. This
guide is intended for both system and functional administrators.
PLA 3.0 consists of a framework and add-ons. The PLA 3.0 framework provides the features you
need to achieve regulatory compliance. It handles data as electronic documents and supports
access control, data integrity, security, validation, and traceability. PLA 3.0 add-ons, such as
the Biological Assays Package for the pharmaceutical industry or the Dose-Response Analysis
Package, extend the functionality of PLA 3.0 to include the analytical methods your users require.
This guide covers the following PLA 3.0 features:
▪ Databases in PLA 3.0
▪ Extensibility with PLA 3.0
▪ Rights and permissions in PLA 3.0
Databases in PLA 3.0
In PLA 3.0, databases are not just used to store data. Each PLA 3.0 database also defines a work
environment. This includes a range of information from structured documents that hold your
data to user accounts, security contexts, signatures, and audit trails. The first part of this guide
has the information you need to set up, monitor, and maintain PLA 3.0 databases in a compliant
manner.
Extensibility with PLA 3.0
PLA 3.0 add-ons offer the analytical methods your users require and enable them to visualize,
document, and report results. They also support a range of additional tasks from data
acquisition to data aggregation and process monitoring using control charts. The second part of
this guide has the information you need to install add-ons and make their functionality available
to the users of particular PLA 3.0 databases.
Rights and permissions in PLA 3.0
PLA 3.0 provides the features you need to control access to your data in a sophisticated and
compliant manner. It combines role-based user rights with resource-based permissions, which
enable you to exercise very fine-grained control over who is allowed to perform particular tasks
in a given context and which tasks are allowed with particular data. The third part of this guide
has the information you need to set up users, groups, security contexts, and more.
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2 Databases in PLA 3.0
In PLA 3.0, databases are not just used to store data. Each PLA 3.0 database also defines a work
environment. This includes a range of information from structured documents that hold your
data to user accounts, security contexts, signatures, and audit trails.
We therefore recommend using separate databases for tasks that require different work
environments. For example, use one database to test setups for databases and documents and a
second database for production.
Current regulations, such as 21 CFR 11.10 in the pharmaceutical industry, require you to ensure
that only authorized individuals can access your systems, perform operations, and sign records.
The database-driven approach of PLA 3.0 enables you to take major steps toward meeting these
requirements. Since most settings in PLA 3.0 apply to individual databases, you can differentiate,
for example, between production and test databases.
To enable you to create new databases more efficiently, PLA 3.0 provides a database template
feature. You use existing databases as templates for creating new databases.
Note: PLA 3.0 supports two database types, that is, file-based SQLite databases and
Microsoft SQL Server databases. We recommend Microsoft SQL Server databases for production
purposes and simultaneous access in multi-user environments.

2.1 Database settings
Establish consistent policies for a range of features, such as passwords, signatures, and
traceability, that control and document user access to individual databases.
Use the following dialogs to tailor database settings to your needs:
Dialog

Description

Database policies

System-idle lock, password policies, compliant signatures,
traceability of changes to documents and protected values,
database templates.

Database info

Description of database, dashboard for database.

Configuration Report

Report on database configuration.

2.1.1 Database policies
Control and document aspects of how users access individual databases.
Navigation: System > Database policies
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Use the Database policies dialog to set password policies and the system-idle lock, enable
compliant electronic signatures, require users to specify why they change data, enable database
templates, and more.

2.1.1.1 Security
Set the system-idle lock and password policies for individual databases to ensure that the
passwords of authorized users are sufficiently strong and that users change their passwords as
often as deemed necessary by your organization.
Navigation: System > Database policies > Security
Tip: PLA 3.0 allows you to use directory services based on LDAPS, such as Microsoft Active
Directory Domain Services, to handle user authentication. Active Directory allows you to enforce
greater password complexity and prevent user names from being employed as passwords.
Please consult the Directory service configuration section for more information.
System section
The following items are available:
Item

Description

Idle lock interval [min]

The system automatically locks for users who have stopped
interacting with it for the number of minutes specified here.
Users who are locked out have to re-enter their password.
Enter 0 to disable this option.

Support requests

Specifies whether users can send support requests.
Available options:
▪ Activated: Users can send requests.
▪ Activated (without documents): Users can send requests
but cannot attach documents to their requests.
▪ Deactivated: User cannot send requests.

Sending feedback

Specifies whether users can send feedback.
Available options:
▪ Activated: Users can send feedback.
▪ Activated (without documents): Users can send feedback
but cannot attach documents to their feedback.
▪ Deactivated: User cannot send requests.
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Password section
Note: The password policy settings are primarily intended for file-based SQLite databases
that do not provide their own access control beyond the file system permissions of the database
files. We recommend Microsoft SQL Server databases for production purposes and simultaneous
access in multi-user environments.
The following items are available:
Item

Description

Minimum length

The system accepts passwords that do not have fewer
characters than the number specified here.
Note: The number you enter for Minimum length cannot
be greater than Maximum length.

Minimum number of special
characters

The system accepts passwords that do not have fewer special
characters than the number specified here. Special characters
are characters that are neither letters nor numbers such as @,
#, !, ", %, &, (, ), *, +.
Note: The number you enter for Minimum number of
special characters cannot be greater than Maximum length.

Maximum length

The system accepts passwords that do not have more
characters than the number specified here.
Note: The number you enter for Maximum length cannot
be less than Minimum length.

Maximum age [d]

The system accepts passwords that are not older than the
number of days specified here. Users have to change their
password when it has reached Maximum age. Enter 0 to
disable this option.
Note: The number you enter for Maximum age cannot be
less than Minimum age.
Tip: Current regulations, such as 21 CFR 11.300(b) in the
pharmaceutical industry, require you to implement policies
regarding password aging.

Warning age [d]

Prompts users to change passwords that are older than the
number of days specified here. Enter 0 to disable this option.
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Item

Description

Minimum age [d]

Allows users to change passwords that are at least as old as
the number of days specified here. Enter 0 to disable this
option.
Note: The number you enter for Minimum age cannot be
greater than Maximum age.
Tip: Enable this option in conjunction with a password
history policy (see History length option below) to effectively
discourage users from reusing old passwords.

Maximum age blocks
account

Locks user accounts whose password has reached Maximum
age. An administrator has to access PLA 3.0 and unlock user
accounts whose password has reached Maximum age.
Warning: If you enable this option and the password
of the Administrator account reaches Maximum age, the
administrator is locked out of the system.
Note: If you disable this option, users still have to change
their password when it has reached Maximum age. Yet no
unlock action by an administrator is required (see: System >
Account management > Users > Unlock now).

Maximum failures

Locks user accounts that have the number of failed
consecutive logins specified here.

Failure grace interval [min]

Locks user accounts for the number of minutes specified
here when they have reached Maximum failures. Enter 0 to
keep accounts locked until an administrator unlocks them
manually.

History length

Specifies the number of consecutive unique passwords
saved for individual user accounts. Determines how often
users have to change their password before they can reuse
previous passwords of the same account.
Enter 0 to keep all previous passwords and prevent
passwords from being used ever again for the same account.
Tip: Enable this option in conjunction with a password
minimum age (see the Minimum age option setting) to
effectively discourage users from reusing old passwords.
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Item

Description

List of invalid passwords

Prevents the character strings listed from being used as
passwords. Click Edit to open the Manage invalid passwords
dialog, where you can edit the Invalid passwords list.
Note: This feature is case-sensitive. If you add the
character string "password" to the list, you do not prevent
users from using "Password."

Example: Password policies
The following table provides an example of valid entries for all password policy options.
Item

Example of valid setting

Minimum length

8

Minimum number of special characters

1

Maximum length

16

Maximum age [d]

90

Warning age [d]

14

Minimum age [d]

3

Maximum age blocks account

enabled

Maximum failures

2

Failure grace interval [min]

0

History length

5

List of invalid passwords

password
Password

2.1.1.2 Signatures and regulatory compliance
Enable electronic signatures. Specify how signatures are created and how signed documents
are handled to make signatures compliant with current regulations such as 21 CFR 11.100 and
11.200 in the pharmaceutical industry.
Navigation: System > Database policies > Signatures
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General section
The following items are available:
Item

Description

Requires user name

Requires users to enter their user name every time they want
to sign documents or remove signatures. The system only
accepts the user name of the user who is currently logged in.
Note: If you disable this option, the user name of the
current user is recorded automatically.

Document signatures section
The following items are available:
Item

Description

Templates for electronic
signatures

Provides users with a list of valid reasons for signing
documents and removing signatures.
Note: When users sign a document or remove a signature
and are prompted to provide a reason for their actions, they
can either type the reason into a text box or select an option
provided by the Template list.
Tip: You can edit the list of available templates by clicking
Edit.

Deny signature removal

Prevents the removal of signatures even by users who have
the permissions required to remove signatures.

Deny deletion of signed
documents

Prevents the deletion of signed documents even by users
who have the permissions required to delete signed
documents.

Deny deletion of documents
containing signatures

Prevents the deletion of documents that contain signed
sections or "scopes" even by users who have the permissions
required to delete signed sections or "scopes."

Example: Signature compliance with 21 CFR Part 11
Select the following options to make your signatures compliant with 21 CFR Part 11.
Item

Required setting

Requires user name

enabled
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Item

Required setting

Deny signature removal

enabled

Deny deletion of signed documents

enabled

Deny deletion of documents containing
signatures

enabled

Examples: Using the 'Templates for electronic signatures' and 'Require user name' settings
These examples show the Apply electronic signature dialog, which prompts users to enter
information when they sign documents or remove signatures. The screenshots and descriptions
indicate how the Templates for electronic signatures and Require user name settings affect the
dialog.
Example 1
The following figure shows the dialog with the Template drop-down list displayed. The list
consists of all entries provided in the Manage templates dialog, which you access from the
Signatures tab of the Database policies dialog.

Figure 2-1 Apply electronic signature dialog with Template drop-down list

Tip: If your organization provides standardized reasons for signing documents and removing
signatures, users can select one from the Template drop-down list, which is then inserted in the
Meaning text box. Users can still type additional information into the text box.
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Example 2
The following figure shows the dialog with the Requires user name option enabled on the
Signatures tab. It displays three text boxes where users enter the reason for signing, their user
name, and their password.

Figure 2-2 Apply electronic signature dialog with enabled Requires user name option

Note: Some regulations, such as 21 CFR 11.200 in the pharmaceutical industry, require
signatures to "employ at least two distinct identification components." Your organization is on
the safe side if you require users to manually enter both user name and password provided that
user name and password are not identical strings.
Example 3
The following figure shows the dialog with the Requires user name option disabled on the
Signatures tab. It displays two text boxes where users enter the reason for signing and their
password.
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Figure 2-3 Apply electronic signature dialog with disabled Requires user name option

Note: PLA 3.0 automatically inserts the user name of the current user, which is
"Administrator" in this example.

2.1.1.3 Traceability
Adjust how PLA 3.0 traces changes to documents and protected values. Require users to specify
why they modify documents and protected values to improve traceability and protect data from
intentional and unintentional changes.
Navigation: System > Database policies > Traceability
Changes to documents section
Tip: You can edit the list of available templates by clicking Edit.
The following items are available:
Item

Description

Templates for reasons for
change

Provides users with a list of valid reasons for making changes
to documents.
Note: When users save a document, they can either type
the reason into a text box or select an option provided by the
Template list.
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Item

Description

Request reason for change

Specifies whether users who save a document are prompted
to explain why they made changes to the document.
Available options:
▪ Never: When users save a document after making
changes, they cannot provide a reason for their changes.
▪ Optional: Displays the Reason for change dialog when
users save a document, where they can enter a reason for
their changes.
Note: Users can leave the Reason for change dialog
empty and still save the document.
▪ Always: Displays the Reason for change dialog when users
save a document. They cannot save the document without
entering a reason for their changes.
▪ Always after initial saving: Displays the Reason for change
dialog when users save a document. The dialog does
not get displayed when users save a new document for
the first time. In all other cases, users cannot save the
document without entering a reason for their changes.

Templates for reasons for
move

Provides users with a list of valid reasons for moving
documents.
Note: When users move a document, they can either type
the reason into a text box or select an option provided by the
Template list.

Request reason for move

Specifies whether users who move a document are prompted
to explain why they want to move the document.
Available options:
▪ Never: When users move a document, they cannot provide
a reason for the move.
▪ Optional: Displays the Template list and Reason text box
when users move a document, allowing them to enter a
reason for the move.
Note: Users can leave the Reason empty and still move
the document.
▪ Always: Users cannot move a document without entering a
reason for the move.
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Item

Description

Templates for reasons for
delete

Provides users with a list of valid reasons for deleting
documents.
Note: When users delete a document, they can either
type the reason into a text box or select an option provided
by the Template list.

Request reason for delete

Specifies whether users who delete a document are
prompted to explain why they want to delete the document.
Available options:
▪ Never: When users delete a document, they cannot
provide a reason for the deletion.
▪ Optional: Displays the Template list and Reason text box
when users delete a document, allowing them to enter a
reason for the deletion.
Note: Users can leave the Reason empty and still delete
the document.
▪ Always: Users cannot delete a document without entering
a reason for the deletion.

Changes to protected values section
Tip: You can edit the list of available templates by clicking Edit.
The following items are available:
Item

Description

Templates for reasons for
change

Provides users with a list of valid reasons for making changes
to protected values.
Note: When users change a protected value, they can
either type the reason into a text box or select an option
provided by the Template list.
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Item

Description

Manual change

Specifies whether users are permitted to change protected
values and, if they are permitted, whether users are
prompted to explain why they made changes and whether
they have to provide their user name and password.
Available options:
▪ Forbidden: No changes are permitted. In the Observations
table and related data views, protected values are grayed
out and not available for editing.
▪ Permitted with reason and signature: Changes are
permitted, but users are prompted to provide a reason for
their changes and to enter their user name and password.
Note: With this setting, the dialog displayed to prompt
users depends on how signatures are set up. Users are
always prompted to enter a reason for their changes
and their password. In addition, users are prompted to
enter their user name if the Requires user name option is
enabled on the Signatures tab.
▪ Permitted with reason: Changes are permitted, but users
are prompted to provide a reason for their changes.
▪ Permitted: Changes are permitted.
Note: Irrespective of the option you select, PLA 3.0
adds an annotation to protected values that have been
modified. To display the annotation, right-click the value
in the Observations table and select the Show annotations
option from the context menu.

Change by import

Specifies whether data acquisition processes are permitted to
change protected values.
Available options:
▪ Forbidden: No changes are permitted. In the Observations
table and related data views, protected values are grayed
out and cannot be modified by another import or data
acquisition.
▪ Permitted: Changes are permitted.
Note: Irrespective of the option you select, PLA 3.0
adds an annotation to protected values that have been
modified. To display the annotation, right-click the value
in the Observations table and select the Show annotations
option from the context menu.
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Item

Description

Change technical outlier
state

Specifies whether users are permitted to change the technical
outlier state (true or false) of observed values and, if they are
permitted, whether users are prompted to explain why they
made changes and whether they have to provide their user
name and password.
Available options:
▪ Forbidden: No changes are permitted. In the Observations
table, technical outlier states are grayed out and not
available for editing.
▪ Permitted with reason and signature: Changes are
permitted, but users are prompted to provide a reason for
their changes and to enter their user name and password.
Note: With this setting, the dialog displayed to prompt
users depends on how signatures are set up. Users are
always prompted to enter a reason for their changes
and their password. In addition, users are prompted to
enter their user name if the Requires user name option is
enabled on the Signatures tab.
▪ Permitted with reason: Changes are permitted, but users
are prompted to provide a reason for their changes.
▪ Permitted: Changes are permitted.
Note: Irrespective of the option you select, PLA 3.0 adds
an annotation to technical outlier states that have been
modified. To display the annotation, right-click the value
in the Observations table and select the Show annotations
option from the context menu.

Examples: Using the 'Permitted with reason' and 'Permitted with reason and signature'
settings
These examples show the Set technical outlier state dialog, which prompts users to enter
information when they change the technical outlier state (true or false) of observed values. The
screenshots and descriptions indicate how the settings Permitted with reason and Permitted
with reason and signature settings affect the dialog. They also indicate how the Requires user
name option of the Signatures tab affects the dialog when the setting Permitted with reason
and signature is enabled.
Tip: Apply these settings under Manual change rather than Change technical outlier state to
define the dialog that prompts users when they manually change protected values.
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Example 1
The following figure shows the dialog for the setting Permitted with reason. It displays one text
box where users enter the reason for changing the technical outlier state of an observed value.

Figure 2-4 Set technical outlier state dialog with Permitted with reason option enabled

Tip: If your organization provides standardized reasons, users can select one from the
Template drop-down list, which is then inserted in the Reason text box. Users can still type
additional information into the text box.
Example 2
The following figure shows the dialog for the setting Permitted with reason and signature
with the Requires user name option enabled on the Signatures tab. It displays three text boxes
where users enter the reason for making changes, their user name, and their password.
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Figure 2-5 Set technical outlier state dialog with Permitted with reason an Requires user name options enabled

The following figure shows the dialog for the setting Permitted with reason and signature with
the Requires user name option disabled on the Signatures tab. It displays two text boxes where
users enter the reason for making changes and their password.
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Figure 2-6 Set technical outlier state dialog with Permitted with reason option enabled and Requires user
name option disabled

Note: PLA 3.0 automatically inserts the user name of the current user, which is
"Administrator" in this example.

2.1.1.4 Attachments
Enable the use of manual attachments and specify the types of attachments users should be
allowed to work with.
Navigation: System > Database policies > Attachments
Note: This setting does not impact the handling of automatically generated attachments
such as the generation of plots during assay calculation.
Manual attachments section
The following items are available:
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Item

Description

Modify attachments

Specifies whether users are allowed to modify manual
attachments.
Available options:
▪ Permitted: Users can modify manual attachments.
▪ Files only: Users can modify attachments of the type file
only.
▪ Links only: Users can modify linked attachments only.
▪ Denied: Users cannot modify manual attachments.
Tip: You can permit manual attachments in general and
use permissions to set up restrictions on user-level.

Modify attachments of
signed documents

Specifies whether users are allowed to modify manual
attachments from signed documents.
Available options:
▪ Permitted: Users can modify manual attachments of signed
documents.
▪ Attach only: Users can only add additional attachments to
signed documents.
▪ Denied: Users cannot modify manual attachments of
signed documents.

Maximum size [KB]

Specifies the maximum size of a manual attachment in KB.
The default setting is 10240.

Allowed / blocked file
extension

Manage a list of file extension that should explicitly be
allowed or blocked as attachments. By default, .com and .exe
file are blocked.

2.1.1.5 Barcodes
Set the barcode type used by PLA 3.0 and the size of the generated barcodes.
Navigation: System > Database policies > Barcodes
Format section
The following items are available:
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Item

Description

Barcode type

Select the type of barcode PLA 3.0 should use.
Available options:
▪ QR Code (two-dimensional)
▪ Code 128 (one-dimensional)
Note: We recommend to use a two-dimensional barcode,
as additional information such as the UUID of the database is
stored in it.

Width (pixels)

Specify the width in pixels of the barcode to be generated by
PLA 3.0.

Height (pixels)

Specify the height in pixels of the barcode to be generated
by PLA 3.0.

2.1.1.6 Advanced
Enable draft components, use of databases as templates, changes to document and folder keys,
and automatic saving of new, unedited documents.
Navigation: System > Database policies > Advanced
Development section
The following items are available:
Item

Description

Activate draft components

Enables users to preview and test custom components, such
as custom reports, in draft mode prior to their release.
Note: You do not need this feature if users only work with
components that have been released.

Behavior section
The following items are available:
Item

Description

Allow usage as database
template

Enables users who create new databases to employ this
database as a template.
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Documents and folders section
The following items are available:
Item

Description

Deny change document or
folder keys

Prevents changes to document keys and folder keys even by
users who have the permissions required to change these
keys.

Save new documents before
editing the first time

Causes new, unedited documents to be saved automatically.
Available options:
▪ Always: Induces automatic saving of all new documents.
▪ Only at creation from templates: Only induces automatic
saving when users create new documents from templates.
▪ Never: Disables automatic saving of new documents.
Note: With this feature enabled, PLA 3.0 creates empty
documents in the database and then opens them for editing.
With this feature disabled, PLA 3.0 opens empty documents
in the editor and only adds them to the database when users
manually save them for the first time.
Tip: Enable this feature to ensure that PLA 3.0 logs all
changes to documents from their creation. If users create
documents from templates, this allows you to track all
changes that cause discrepancies between documents and
templates.

Default PDF report option section
The following items are available:
Item

Description

Create read-only reports

Causes PDF reports to be created read-only.
Tip: Use this option to prevent changes to the report
content.

Database section
The following items are available:
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Item

Description

UUID

Displays the universally unique identifier of databases.

2.1.2 Database info
Provide information on databases to improve navigation and to support users who work with
them.
Navigation: System > Database info
Summary tab
The following items are available:
Item

Description

Database name

PLA 3.0 displays the information you enter here in the
Database management dialog when users employ this
database as a template to create new databases.

Brief description

Note: Users can employ this database as a template if the
Allow usage as database template option is enabled on the
Advanced tab of the Database policies dialog.
Detailed information tab
PLA 3.0 displays the information you enter here on the database dashboard when users open
the database.
Tip: Use this feature to provide pertinent, HTML-formatted information to all users of the
database.

2.1.3 Database configuration report
Enable authorized users to generate customized PDF reports that document and communicate
pertinent information on database configurations.
Navigation: System > Configuration report
The following items are available:
Item

Description

Target folder

Specifies the folder where database configuration reports are
to be stored.
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Item

Description

Report configuration

Specifies the items to be included in database configuration
reports.
Tip: Please consult the User Guide for details on the
permissions users require to access specific database
configuration items.

Proceed

Starts the report creation. A progress dialog shows the
configuration items and corresponding process status.

2.2 Database monitoring
Monitor user sessions and document locks. Maintain a permanent record of all relevant events
related to user access, changes in work environments, and changes to data for each individual
PLA 3.0 database and document.
Use the following dialogs to access database monitoring features:
Dialog

Description

Session management

View and manage the sessions of all users who are currently
connected to the database.

Audit trail (system and
document context)

Interpret the audit trail. Track and communicate events
related to user access, changes in work environments, and
changes to data for each individual PLA 3.0 database and
document.

2.2.1 Session management
View and manage the sessions of all users who are currently connected to the database. The
upper table of the Session management dialog lists all sessions. Select a session to display all its
document locks in the lower table.
Navigation: System > Session management
Session management in PLA 3.0
When users log into PLA 3.0 databases, PLA 3.0 assigns separate sessions to individual users.
Each session is valid for one particular user and database and has a unique ID, which PLA
3.0 saves to the database. When users open PLA 3.0 documents, their session IDs lock the
documents for other users. PLA 3.0 unlocks documents when users close them. When users log
out of databases, PLA 3.0 unlocks all documents locked by their session IDs and deletes their
session IDs from the databases.
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Note: PLA 3.0 checks every five minutes if sessions are obsolete. When users get
disconnected from databases, PLA 3.0 deletes their sessions.
Administration of sessions and locks
The following items are available:
Item

Description

Auto-refresh rate

Specifies whether the session and lock tables displayed in the
dialog are to be automatically refreshed. The drop-down list
provides time interval options in seconds (s) and minutes (m).

Refresh

Refreshes the session and lock tables displayed in the dialog.

Delete session

Terminates the session currently selected in the dialog, and
unlocks all its documents and folders.
Note: We do not recommend to use this command unless
obsolete sessions remain after users failed to properly close
PLA 3.0.

Remove all locks

Unlocks all documents that belong to the session currently
selected in the dialog.
Note: We do not recommend to use this command unless
documents remain locked by obsolete sessions after users
failed to properly close PLA 3.0.

Remove lock

Unlocks the document currently selected in the dialog.
Note: We do not recommend to use this command unless
documents remain locked by obsolete sessions after users
failed to properly close PLA 3.0.

2.2.2 Audit trail
Interpret the audit trail. Track and communicate events related to user access, changes in work
environments, and changes to data for each individual PLA 3.0 database and document. The
upper table of the Audit trail dialog lists all recorded actions. Select an action to display all
affected elements and their values in the lower table.
PLA 3.0 provides both system and document audit trails:
Navigation: System > Audit trail
Navigation: Open document > Action bar > Audit
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Audit trails and regulatory compliance
Current regulations, such as 21 CFR 11.10 in the pharmaceutical industry, require you to
document user access to the system and all actions that create, modify, or delete records. PLA
3.0 audit trails enable you to take major steps toward meeting these requirements. PLA 3.0
provides a separate secure audit trail for each individual PLA 3.0 database and document.
Audit trails record all user login and logout events of individual databases, all changes to the
database settings, and all changes to the documents saved in individual databases. For every
recorded event, audit trails provide a time stamp and all modified values.
System and document audit trails provide the following information:
Audit trail type

Information

System audit trail

Contains all recorded events of an individual database.

Document audit trail

Contains all recorded events that relate to an individual
document. The events provided by a document audit trail
are a subset of those recorded in the system audit trail of the
document's database.
Note: Some system events are not included in the
document audit trails.

Note: Users require permissions to access system and document audit trails. Please consult
the Global permissions section for more information.
PLA 3.0 provides advanced features to enhance the experience of users who work with audit
trails:
▪ Filter dialog: Filter the entries of individual audit trails by user, date, action, and object.
▪ Export dialog: Export entire audit trails or the entries provided by previously defined filters.
Please consult the Audit trail section of the User Guide for more information.
Information recorded in audit trails
Each audit trail entry provides the following information on an individual action.
Section

Item

Description

Audit trail table
(upper table)

#

Consecutive number of the audit trail entry
provided in this table row: These numbers
are unique within the audit trails of individual
databases.
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Section

Object table (lower
table)

Item

Description

Time stamp

Time of entry: PLA 3.0 provides time stamps
with millisecond precision. Time stamps are
not necessarily unique within audit trails.

Action

Action type key: PLA 3.0 provides uniform
keys to indicate what type of action has been
recorded.

Object

Object name: The action recorded in this
table row was performed on this object.

Operator

User name of the operator: This PLA 3.0 user
performed the action recorded in this table
row.

Host name

NetBIOS name of the computer: The PLA
3.0 instance used to perform the action was
started on this computer.

Serial

PLA 3.0 license used: Depending on the type
of license used, this may be a protection key
ID, a serial number or hardware ID, or a test
version ID.

Key

Object property: The object properties listed
in this column were affected by the action
selected in the upper table.

Operation

Operation type: This type of operation was
performed on the object property listed in
this table row.

Old value

Value of the element prior to the operation: If
the operation created the element, no value
is displayed. The values of passwords are
never displayed.

New value

Value of the element after the operation: If
the operation deleted the element, no value
is displayed. The values of passwords are
never displayed.

Actions and their keys recorded in audit trails
Please consult the following sections for details:
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▪ Schemas
▪ Information packages
▪ Add-ons, components, OQ packages, and OSGI bundles
▪ IQ, OQ, PQ
▪ Users and sessions
▪ User groups
▪ User roles
▪ Folder properties, folder restrictions, and security contexts
▪ Information packages
▪ Database policies and database properties
▪ Database locks and system locks
▪ Database maintenance
▪ Object, data, and document
▪ Attachments

2.2.2.1 Schemas
The following table lists the actions recorded in audit trails for schemas and the keys used to
represent them.
Item

Description

SCHEMA_INIT

The database schema was initialized.

SCHEMA_UPDATE

The database schema was updated.

2.2.2.2 Information packages
The following table lists the actions recorded in audit trails for information packages and the
keys used to represent them.
Action

Description

INFORMATIONPACKAGE_INITIAL

An information package was imported for
the first time for this serial number.

INFORMATIONPACKAGE_SAVED

An information package was updated for this
serial number.

2.2.2.3 Add-ons, components, OQ packages, and OSGI bundles
The following table lists the actions recorded in audit trails for add-ons, components, QQ
packages, and OSGI bundles and the keys used to represent them.
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Action

Description

COMPONENT_INITIAL

A component was created.

COMPONENT_SAVED

A component was saved.

COMPONENT_UPDATED

A component was updated.

COMPONENT_IMPORTED

A component was imported because a
package was installed.

COMPONENT_DELETED

A component was deleted.

ADDON_ACTIVATED

An add-on was activated in the database.

ADDON_DEACTIVATED

An add-on was deactivated in the database.

ADDON_CATALOG_IMPORTED

An add-on catalog file was imported.

OQPACKAGE_INITIAL

An OQ package was created.

OQPACKAGE_DELETED

An OQ package was deleted.

OSGIBUNDLE_INITIAL

An OSGI bundle was created.

OSGIBUNDLE_DELETED

An OSGI bundle was deleted.

2.2.2.4 IQ, OQ, PQ
The following table lists the actions recorded in audit trails for IQ, OQ, and PQ and the keys used
to represent them.
Action

Description

IQ_EXECUTED

An installation qualification was executed.

OQ_IMPORTED

An operational-qualification package was
imported.

OQ_EXECUTED

An operational qualification was executed.

OQ_EXPORTED

An operational-qualification package was
exported.

PQ_IMPORTED

A performance qualification package was
imported.

PQ_EXECUTED

A performance qualification was executed.
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Action

Description

PQ_EXPORTED

A performance qualification package was
exported.

2.2.2.5 Users and sessions
The following table lists the actions recorded in audit trails for users and sessions and the keys
used to represent them.
Action

Description

USER_INITIAL

A user was created.

USER_SAVED

Changes to a user were saved.

USER_DELETED

A user was deleted.

USER_SESSION_OPENED

A user logged into the database, and a
session was created for the user.

USER_SESSION_DENIED

A user tried to log into the database, but the
login failed.

USER_SESSION_CLOSED

A user logged out of the database, and the
session of the user was deleted.

USER_SESSION_DELETED

A user session was deleted in the database or
from the Session management dialog.

USER_PASSWORD_CHANGED

A user account password was changed or
reset.

2.2.2.6 User groups
The following table lists the actions recorded in audit trails for user groups and the keys used to
represent them.
Action

Description

GROUP_INITIAL

A user group was created.

GROUP_SAVED

Changes to a user group were saved.

GROUP_DELETED

A user group was deleted.
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2.2.2.7 User roles
The following table lists the actions recorded in audit trails for user roles and the keys used to
represent them.
Action

Description

ROLE_INITIAL

A user role was created.

ROLE_SAVED

Changes to a user role were saved.

ROLE_DELETED

A user role was deleted.

2.2.2.8 Folder properties, folder restrictions, and security contexts
The following table lists the actions recorded in audit trails for folder properties, folder
restrictions, and security contexts and the keys used to represent them.
Action

Description

CONFIGURATIONCONTEXT_INITIAL

A configuration for the document key format
was created.

CONFIGURATIONCONTEXT_SAVED

Changes to a configuration for the document
key format were saved.

CONFIGURATIONCONTEXT_DELETED

A configuration for the document key format
was deleted.

RESTRICTIONCONTEXT_INITIAL

A configuration for document restrictions
was created.

RESTRICTIONCONTEXT_SAVED

Changes to a configuration for document
restrictions were saved.

RESTRICTIONCONTEXT_DELETED

A configuration for document restrictions
was deleted.

SECURITYCONTEXT_INITIAL

A security context was created.

SECURITYCONTEXT_SAVED

Changes to a security context were saved.

SECURITYCONTEXT_DELETED

A security context was deleted.

FOLDER_PROPERTIES_SAVED

Changes to folder properties were saved.
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2.2.2.9 Database policies and database properties
The following table lists the actions recorded in audit trails for database policies and database
properties and the keys used to represent them.
Action

Description

HTMLFRAGMENT_INITIAL

The HTML fragment for the database
dashboard was created.

HTMLFRAGMENT_SAVED

Changes to the HTML fragment for the
database dashboard were saved.

HTMLFRAGMENT_DELETED

The HTML fragment for the database
dashboard was deleted.

DB_POLICIES_SAVED

Changes to the database policies were saved.

DATABASE_PROPERTIES_SAVED

Changes to the database properties were
saved.

LDAP_PROPERTIES_SAVED

Changes to the LDAP properties were saved.

2.2.2.10 Database locks and system locks
The following table lists the actions recorded in audit trails for database locks and system locks
and the keys used to represent them.
Action

Description

DB_ADMINACCESS_ON

The database was locked for exclusive access.

DB_ADMINACCESS_OFF

A lock for exclusive database access was
removed.

SYSTEM_LOCKED

PLA 3.0 was locked.

SYSTEM_UNLOCKED

PLA 3.0 was unlocked.

SYSTEM_UNLOCKREJECTED

An attempt to unlock PLA 3.0 was rejected.

ACCOUNT_MANAGEMENT_LOCKED

The account management of the database
was locked.

ACCOUNT_MANAGEMENT_UNLOCKED

The account management of the database
was unlocked.
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Action

Description

ARTIFACT_MANAGEMENT_LOCKED

Artifact management was locked, that
is, component, package, and add-on
management.

ARTIFACT_MANAGEMENT_UNLOCKED

Artifact management was unlocked, that
is, component, package, and add-on
management.

DB_POLICIES_LOCKED

The database policies were locked.

DB_POLICIES_UNLOCKED

The database policies were unlocked.

DB_PROPERTIES_LOCKED

The database properties were locked.

DB_PROPERTIES_UNLOCKED

The database properties were unlocked.

OBJECT_LOCK_DELETED

An object was unlocked from the Session
management dialog.

OBJECT_LOCKS_DELETED

All objects were unlocked from the Session
management dialog.

SESSION_MANAGEMENT_LOCKED

Session management was locked.

SESSION_MANAGEMENT_UNLOCKED

Session management was unlocked.

2.2.2.11 Database maintenance
The following table lists the actions recorded in audit trails for user maintenance and the keys
used to represent them.
Action

Description

DB_MAINTENANCE_START

A new database maintenance was started.

DB_MAINTENANCE_COMPLETE

Database maintenance was completed.

DB_MAINTENANCE_INCOMPLETE

Database maintenance remained incomplete
because it was canceled by a user or because
locked documents were skipped.

DB_MAINTENANCE_CONTINUE

Incomplete database maintenance was
resumed.

DB_MAINTENANCE_REGISTRYUPDATED

Database maintenance caused the list of
document properties to be reinitialized.
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2.2.2.12 Object, data, and document
The following table lists the actions recorded in audit trails for object, data, and document and
the keys used to represent them.
Action

Description

DATA_ACQUIRED

Data were successfully acquired for a
document.

DATA_ACQUIRED_CANCELED

Data acquisition was canceled.

DATA_ACQUIRED_FAILED

Data acquisition failed.

DOC_KEY_CHANGED

A document key was changed.

OBJECT_INITIAL

An object was created.

OBJECT_IMPORTED

An object was imported.

OBJECT_UPGRADE

The document type version of a document
was upgraded.

OBJECT_SAVED

Changes to an object were saved.

OBJECT_MOVED

An object was moved.

OBJECT_SIGN

A signature was applied to a document.

OBJECT_REMOVESIGNATURE

A signature was removed from a document.

OBJECT_COPIED_FROM

This object is a copy of another object.

OBJECT_COPIED_TO

A copy of this object was created.

OBJECT_EXECUTE_TASK

An action was executed on this object.

OBJECT_EXPORTED

An object was exported.

OBJECT_DELETE

An object was deleted.

2.2.2.13 Attachments
The following table lists the actions recorded in audit trails for attachments and the keys used to
represent them.
Action

Description

OBJECT_ATTACHMENT_ADDED

An attachment was added to a document.
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Action

Description

OBJECT_ATTACHMENT_SAVED

An attachment was saved.

OBJECT_ATTACHMENT_REMOVED

An attachment was removed from a
document.

2.3 Database maintenance
Perform database maintenance. By default, only system administrators have the permissions
required to perform database maintenance.
Note: Depending on the database, maintenance may take considerable time.

Procedure

To perform database maintenance:
1. From the System menu, select Database maintenance.
2. Select the Mode you want to use for the database maintenance:
Option

Description

Start new maintenance

Starts a new database maintenance.
Note: This writes a DB_MAINTENANCE_STARTED entry
to the audit trail.

Start new maintenance
with reinitialization of the
list of document properties

Starts a new database maintenance that also reinitializes
the list of document properties. Use this option if your
Biological assay package is older than version 24 and you
upgrade to version 24 or newer.
Note: This operation temporarily locks the database.

Resume incomplete
maintenance

Resumes the most recent database maintenance.
Tip: This option only becomes available when
maintenance has not been completed, which occurs when
users cancel maintenance or maintenance skips documents
because they are locked.

3. Click Proceed.

A progress dialog shows the maintenance steps.
Note: The Rebuilding digest task is performed when structural changes occur in the
document digest. This may require an update of existing documents.
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Result: The yellow status bar at the bottom of the dialog displays the result and supporting
information.
Message

Description

Database maintenance
complete

Confirms that all maintenance tasks have been completed
successfully.

Database maintenance
incomplete

Indicates that either a user canceled maintenance or
documents were skipped because they were locked. When
maintenance is incomplete, the Resume incomplete
maintenance option becomes available in the Database
maintenance dialog.
Note: This writes a DB_MAINTENANCE_INCOMPLETE
entry to the audit trail.

Database maintenance
failed

Results from an internal error. Database maintenance was
not executed.

What to do next

To generate and display a PDF document with log information, click Log. The document contains
the information displayed in the progress dialog and the following information on how the PDF
document was generated:
▪ Database: Name of the database
▪ PLA 3.0 version
▪ S/N: Serial number of PLA 3.0 license
▪ User: User name
▪ Workstation: Name of the computer
▪ Timestamp: Date and time of PDF document generation
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3 Extensibility with PLA 3.0
The PLA 3.0 framework provides the features you need to achieve regulatory compliance.
Add-ons
Add-ons such as the Biological Assays Package for the pharmaceutical industry or the DoseResponse Analysis Package, extend the functionality of the PLA 3.0 framework to include the
analytical methods your users require and enable them to visualize, document, and report
results. They also support a range of additional tasks from data acquisition to data aggregation
and process monitoring using control charts.
If some of your users need to work with a new analytical method, for example, or need to
acquire data from a new instrument, you first install the add-ons required for the task. Once
you have installed new add-ons to extend the functionality of PLA 3.0 or to update existing
functionality, you activate these add-ons for the particular PLA 3.0 databases whose users need
the new functionality.
Note: The users of a PLA 3.0 database can only work with the add-ons and add-on versions
that are currently activated for this particular database. This approach guarantees that all users
of the database work with the same add-ons and with the same add-on versions.
Document structure upgrade
When users work with updated add-ons and try to access PLA 3.0 documents created and
edited with earlier add-on versions, these documents open in read-only mode. Users can
still edit such documents or use the analytical setups of such documents if they upgrade the
structure of the documents
Tip: Please consult the Document structure upgrade section for more information.

3.1 Add-on installation and activation
Install new PLA 3.0 add-ons to extend the functionality of PLA 3.0 or to update existing
functionality. Activate add-ons to make the new functionality available to users of particular PLA
3.0 databases.
To activate add-ons for PLA 3.0 databases, you require a global role that allows you to perform
the Manage add-ons database task (System > Account management > Global roles > General).
To make the functionality of a new add-on available to users, you have to complete the
following steps:
1. Download the add-on or import it into the local PLA 3.0 add-on repository to make it
available on the system.
2. Activate the add-on for the PLA 3.0 databases whose users require the extended or updated
functionality.
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To make add-ons available on the system, you require write permission for the directory that
serves as the local PLA 3.0 add-on repository.

3.1.1 Concepts
Following are the basic concepts you should be familiar with when managing add-ons.
Add-on repository
During the installation of PLA 3.0, a folder is created that will be used to store
the setup files of all your add-ons. The default add-on repository folder is: C:
\ProgramData\Stegmann Systems\PLA 3.0\addons.
You can configure a different path, for example, if you want to set up a central
repository. To do so, select a different add-on repository path in your preferences,
under System > Preferences > General.
Information package
Your information package contains a list of all add-ons you can use, licensed, and not
yet licensed. To manage the add-ons of your information package, you use the Addon tab.
PLA 3.0 database
Add-ons have to be activated in the PLA 3.0 database to make their functionality
available for all users connected to this database. You can activate a different set of
add-ons in different databases.

3.1.2 Add-on management
Make the functionality of new PLA 3.0 add-ons available to the users of PLA 3.0 databases.
Navigation: System > Add-on management
Note: When you make new add-on versions available to users and they try to access PLA 3.0
documents created and edited with earlier add-on versions, these documents open in read-only
mode. Please consult the Document structure upgrade section for more information.
The Add-ons tab lists all available add-ons. And it provides controls to download, install, license,
and uninstall add-ons. This feature is only available for users whose global role allows them to
perform the Manage add-ons database task (System menu > Account management > Global
roles > General).
Toolbar
The toolbar at the top of the Add-ons tab provides a set of actions for maintaining add-ons.
Tip: Activating and deactivating the currently selected add-on version is also possible using
the context menu.
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Action

Item

Description

Activate

Downloads the currently selected add-on version to the
local add-on repository. Activates this add-on version in the
current database.

Deactivate

Deactivates the currently selected add-on version in the
current database. Does not remove the add-on from the
add-on repository.

free text
filter

none

Displays only the add-ons in the list whose name or version
designation contains the character sequence you enter in the
text box.

Filter

Opens a dialog that displays a list of filter criteria and allows
you to apply and remove them.

Reset filter

Restores the default filter, which applies the filter criteria
Compatible add-ons and Latest add-ons to the add-ons list.

Add-ons list
The add-ons list below the toolbar displays the names of all add-ons available with your
information package. Select the name of an add-on to display a brief description in the gray box
at the bottom of the list.
The following information is available for each add-on:
▪ Add-on version and build number
▪ Installation status: Displays the
local add-on repository.

system icon if this version of the add-on is available in the

▪ Activation status: Displays the
current PLA 3.0 database.

database icon if this version of the add-on is activated in the

▪ Release date
▪ License status
Tip: By default, the list only displays the most recent version of add-ons that are compatible
with your PLA 3.0 installation. To display earlier add-on versions, click
Filter in the toolbar and
deactivate the Latest add-ons filter option.
Context menu
Use the context menu to activate, deactivate, install (download to repository, import add-ons to
repository), and uninstall (delete from repository) add-ons. Right-click an add-on in the list to
display the context menu for this particular add-on version.

39/84

DU0036

Tip: Activating and deactivating the currently selected add-on version is also possible from
the toolbar.
The following actions are available from the context menu:
Action
Activate

Icon

Description
Downloads the currently selected add-on version to the
local add-on repository. Activates this add-on version in the
current database.
Tip: To create a PLA 3.0 add-on repository for several
computers or databases, use the Download to repository
and Import add-ons to repository actions.

Deactivate

Deactivates the currently selected add-on version in the
current database. Does not remove the add-on from the
add-on repository.
Tip: To remove the add-on from the add-on repository,
use the Delete from repository action.

Delete from
repository

Removes the add-on version currently selected in the add-on
table from the local add-on repository.

Download to
repository

Downloads the currently selected add-on version to the
local add-on repository. Does not install the add-on for the
current database. Use Activate to install the add-on.
Tip: This option is intended for systems that are
connected to the Internet. If you do not have an active
Internet connection, use the Import add-ons to repository
option instead.

Import
add-ons to
repository

Imports add-ons into the local add-on repository. This
option is intended for systems that are not connected to the
Internet. It opens a dialog where you can navigate to and
select add-ons available on your local drives or network. PLA
3.0 add-ons have the .edpao file extension.
This option does not install the add-on for the current
database. Use the Activate to install the add-on.
Tip: If you have an active Internet connection, use the
Download to repository rather than this option.
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Status bar
The status bar below the add-ons list displays additional information on your information
package and add-on and provides further actions.
Item

Description

text in yellow box

Provides the creation date and time of your information
package.
Tip: If this is not current, select the Refresh information
package option from the System menu to have the most
recent add-ons displayed.

text in gray box

Provides a brief description of the add-on version currently
selected in the add-on list.

Missing dependencies

If the currently selected add-on requires one or more addons that are not activated for the current database, use this
button to view the list of dependent add-on.

Request trial

Opens a form where you can enter and submit the
information required to request a trial of the currently
selected add-on.

Request quote

Opens a form where you can enter and submit the
information required to request a price quote for the
currently selected add-on.

3.2 Document structure upgrade
Upgrade the structure of existing PLA 3.0 documents, or upgrade the structure of copies of
existing PLA 3.0 documents.
Note: This feature is available if the security context of the current folder allows users to
perform the Edit documents document task.
When users work with updated add-ons and try to access PLA 3.0 documents created and
edited with earlier add-on versions, these documents open in read-only mode. Users can
still edit such documents or use the analytical setups of such documents if they upgrade the
structure of the documents
Tip: Since the upgrade structure process is irreversible and discards all results and signatures
contained in documents, the process provides the Upgrade copies of documents option, which
leaves the original documents untouched.
When you make new add-on versions available to users and they try to access PLA 3.0
documents created and edited with earlier add-on versions, the following advanced options
become available in the File menu and in the context menus of the Navigator.
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▪ Upgrade structure when selecting an individual document that was created and edited with
earlier add-on versions.
▪ Upgrade structures in folder when selecting select a folder in the Navigator, irrespective of
whether this particular folder contains or does not contain documents created and edited
with earlier add-on versions.
Tip: Users who open documents that do not contain any signatures except their own can
access the upgrade document structure command directly by clicking the Upgrade structure on
the action bar rather than opening the Upgrade document structures dialog.

3.2.1 Upgrade structure
Update the structure of a documents created and edited with an earlier add-on version to the
document structure of the current version.
Navigation: File > Advanced > Upgrade structure
This type of structure update is available when users select one or several documents to be
upgraded in the Navigator and use the Upgrade structure option to open the dialog.
At the top of the dialog the list of documents currently selected in the Navigator is displayed.
The commands of the dialog apply to these documents.
Item

Description

Upgrade copies of
documents

Select this option if you want to preserve the original
documents. With this option selected, the upgrade structure
process does the following:
▪ Creates copies of the documents whose structure is to be
upgraded.
▪ Deletes all results and signatures in these copies.
▪ Upgrades the document structure of these copies.
▪ Leaves the original documents untouched, and therefore
preserves the results and signatures in the original
documents.
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Item

Description

Upgrade document
structures directly

Select this option if you no longer need the results and
signatures contained in the original documents.
Warning: The upgrade structure process is irreversible
and discards all results and signatures.
With this option selected, the upgrade structure process does
the following:
▪ Deletes all results and signatures in the documents whose
structure is to be upgraded.
▪ Upgrades the document structure of these documents.
Tip: Select this option and deactivate the Upgrade
signed documents option to preserve all signed documents
including the results and signatures contained in these
documents, but no longer need the results contained in
unsigned documents.

Upgrade signed documents

Specifies whether the structure of signed documents is to be
upgraded. This option requires user authentication since it
discards all results and signatures.
Note: With this option enabled, you have to enter your
password below to complete the dialog.

User

Displays the login name of the current user.

Password

When you select the Upgrade signed documents option, this
text box requires the password of the current user.

3.2.2 Upgrade structures in folder
Select a folder and update the structure of all documents in this folder created and edited with
an earlier add-on version to the document structure of the current version.
Navigation: File > Advanced > Upgrade structures in folder
This type of structure update is available when users use the Upgrade structures in folder option
in the File menu or the Navigator to open the dialog.
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Item

Description

Choose the document
modes to upgraded

Specifies the document modes whose structures are to
be upgraded. The commands of the dialog only apply to
documents that belong to the modes you select here.
The following modes are available:
▪ Documents
▪ Templates
▪ PQ definitions

Source folder

Displays both the name and the unique key of the currently
selected folder. The commands of the dialog only apply to
documents contained in this folder and its subfolders.
If the currently selected folder does not contain the
documents whose structure you want to upgrade, click ... to
select a different folder.

Upgrade copies of
documents

Select this option if you want to preserve the original
documents.
With this option selected, the upgrade structure process does
the following:
▪ Creates copies of the documents whose structure is to be
upgraded.
▪ Deletes all results and signatures in these copies.
▪ Upgrades the document structure of these copies.
▪ Leaves the original documents untouched, and therefore
preserves the results and signatures in the original
documents.
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Item

Description

Upgrade document
structures directly

Select this option if you no longer need the results and
signatures contained in the original documents.
Warning: The upgrade structure process is irreversible
and discards all results and signatures.
With this option selected, the upgrade structure process does
the following:
▪ Deletes all results and signatures in the documents whose
structure is to be upgraded.
▪ Upgrades the document structure of these documents.
Tip: Select this option and deactivate the Upgrade
signed documents option to preserve all signed documents
including the results and signatures contained in these
documents, but no longer need the results contained in
unsigned documents.

Upgrade signed documents

Specifies whether the structure of signed documents is to be
upgraded. This option requires user authentication since it
discards all results and signatures.
Note: With this option enabled, you have to enter your
password to complete the dialog.

User

Displays the login name of the current user.

Password

When you select the Upgrade signed documents option, this
text box requires the password of the current user.

45/84

DU0036

4 Rights and permissions in PLA 3.0
PLA 3.0 provides the features you need to control access to your data in a sophisticated and
compliant manner. It combines role-based user rights with resource-based permissions, which
enable you to exercise very fine-grained control over who is allowed to perform particular tasks
in a given context and which tasks are allowed with particular data.
Account management
The account management features combine a role-based approach with security contexts. For
this purpose, PLA 3.0 distinguishes between two types of roles, global and document roles.
▪ You set up global roles for database tasks such as setting up database policies or managing
user sessions. The global roles you assign to users and groups are valid for the entire
database.
▪ You set up document roles for document tasks such as editing documents or applying
electronic signatures.
Assignments of document roles to users and groups define security contexts. You can then apply
these security contexts to folders or folder trees. Every user and group can be part of more than
one security context. So, the document roles of a particular user or group can vary from folder to
folder or from folder tree to folder tree.
Note: Use the account management features to set up users and groups directly in PLA 3.0.
But you can also use directory services based on secure LDAP (LDAPS: Lightweight Directory
Access Protocol over SSL/ TLS) to map PLA 3.0 groups and their roles to user groups defined
elsewhere on your network.
Folder properties and document templates
In addition to the features provided by account management, you can use folder properties
to restrict the content of particular folders to documents generated from particular document
templates. And you can use document templates to define permissions that apply to entire
documents generated from them or just to specific sections within generated documents.
The granularity of permissions you define in document templates even reaches down to the
level of individual data elements such as in biological assays, for example, the preparation
scheme associated with a test sample or the number of replicates defined in a preparation
scheme.

4.1 Users, groups, and global roles
Set up users, groups, and global roles. Assign global roles to users and groups to control who
can perform particular database tasks such as setting up database policies or managing user
sessions.
Use the following PLA 3.0 features to set up global roles and assign them to users and groups:
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Feature

Description

Global roles

Combine database tasks into global roles and assign them
to users and groups to control who can perform particular
database tasks.

User groups

Set up PLA 3.0 user groups to assign them global roles and
combine them with document roles into security contexts.

Directory service
configuration

Use secure LDAP (LDAPS) directory services, such as
Microsoft Active Directory Domain Services, to authenticate
PLA 3.0 users. You map your PLA 3.0 groups, which have
PLA 3.0 roles assigned, to user groups set up on a directory
server.

Users

If you do not have access to LDAP directory services on your
network, you can set up user accounts directly in PLA 3.0.

4.1.1 Global roles
Combine database tasks into global roles and assign them to users and groups to control who
can perform particular database tasks.
Navigation: System > Account management > Global roles
▪ Select the top entry of the Global roles list on the left side of the Account management tab
to display the Roles tab on the right side, where you can create, modify, and delete global
roles for the database.
▪ Expand the Global roles list and select one of the global roles listed to display the General tab
on the right side, where you can assign and remove task permissions for this particular global
role.
Tip: When you create a new database in PLA 3.0, predefined global roles are included and
available from the Account management tab. In the default setup, one of these global roles, the
System administrator global role, is needed for the Administrator account. It is assigned
to the Administrator through membership in the System administrators group and has the
required Manage accounts task permission. All other global roles are intended as examples to
help you set up the global roles you require.

4.1.1.1 Roles tab
Create, modify, and delete global roles for the database.
Toolbar
The toolbar at the top of the Roles tab provides a set of actions for maintaining global roles:
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Action

Icon

Add

Description
Opens the Add global role dialog, where you can create a
new global role in the database. To create a new global role,
enter a name for the new global role and a brief description.
Important: The names of global roles and document
roles have to be unique within the database.

Edit

Opens the General tab for the currently selected global role,
where you can modify the description of this role.

Remove

Opens a dialog where you can delete the currently selected
global role from the database.

free text
filter

none

Reset filter

Displays only the global roles in the table whose name
contains the character sequence you enter in the text box.
Removes the filter criteria you entered.

Table
The table below the toolbar displays details on the currently available global roles.
Item

Description

Name

Lists the names of all global roles set up in the database or, if
you set a filter, of the global roles that match the filter.

Description

Provides brief descriptions of the global roles listed in the
Name column.

4.1.1.2 General tab
Assign and remove task permissions for a particular global role.
Details section
The following items are available:
Item

Description

Name

Displays the name of the currently selected global role.

Description

Allows you to edit the description of the currently selected
global role.
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Item

Description

Translate

Opens the Translate dialog, where you can provide
translations of the description. Please consult the Defining
translations for account-related descriptions section for more
information.

Task permissions section
The following items are available:
Item

Icon

Description

Add

Opens the Add task permission dialog, where you can select
a single task from a list and assign it to the currently selected
global role.

Remove

Removes the currently selected task from the global role.

Task

none

Lists the names of all tasks assigned to the global role.

Description

none

Provides brief descriptions of the tasks listed in the Task
column.

4.1.1.3 Database tasks
The following tasks are available for global roles:
Task

Description

Related menu entry

Database maintenance

Run database maintenance

System > Database
maintenance

Edit database policies

Modify settings in the Database
policies dialog.

System > Database
policies

Execute IQ

Execute an Installation qualification
(IQ).

Validation > Installation
Qualification (IQ)

Execute OQ

Execute an Operational qualification
(OQ).

Validation > Operational
Qualification (OQ)

Note: This requires an active PLA
3.0 Validation Package license.
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Task

Description

Related menu entry

Execute PQ

Execute a Performance qualification
(PQ).

Validation >
Performance
Qualification (OQ)

Note: This requires an active PLA
3.0 Validation Package license.
Lock database

Execute the Lock database command
to lock other users out and have
exclusive access to the database.

System > Lock database

Manage accounts

Modify settings related to the
following account management
features: Global roles, document roles,
groups, security contexts, and users.

System > Account
management

To maintain the database, at least
one user needs to have the Manage
accounts task. In the default setup of
PLA 3.0 databases, the Administrator
has this task due to membership in
the System administrators group,
which has the System administrator
global role assigned.
Note: This task setting does not
affect accessibility of tasks related to
the Change security context feature
(File > Advanced).
Manage add-ons

Perform actions related to the
management of add-ons.

System > Add-on
management

Manage database info

Modify settings in the Database info
dialog.

System > Database info

Manage own account

Edit Details associated with one's
own user account such as the e-mail
address or phone number

System > Account
management > Users

Tip: This task setting only affects
user accounts set up in PLA 3.0 rather
than an external directory.
Manage sessions

View session management, and
execute commands in the dialog.

System > Session
management

Request support

Submit a request for support.

Help > Support request

50/84

Administration Guide | PLA 3.0 | Version 3.0.6

Task

Description

Related menu entry

Send feedback

Send feedback to Stegmann Systems.

Help > Send feedback

Show audit trail

View the system audit trail.

System > Audit trail

Note: This task setting only affects
the system audit trail. The document
audit trails are available for all users
who can view related documents.

4.1.2 User groups
Set up PLA 3.0 user groups to assign them global roles and combine them with document roles
into security contexts. PLA 3.0 allows you to use secure LDAP (LDAPS) directory services to map
your PLA 3.0 groups to user groups defined elsewhere on your network.
Navigation: System > Account management > Groups
▪ Select the top entry of the Groups list on the left side of the Account management tab to
display the Groups tab on the right side, where you create, modify, and delete groups.
▪ Expand the Groups list and select one of the groups listed to display the General tab and the
Roles tab where you can modify the settings of this group and assign it global roles.
Tip: When you create a new database in PLA 3.0, predefined groups are included and
available from the Account management tab. In the default setup, one of these groups, the
System administrators group, is needed for the Administrator account. It has the System
administrator global role assigned, which includes the required Manage accounts task
permission. All other groups are intended as examples to help you set up the groups you
require.

4.1.2.1 Groups tab
Create, modify, and delete user groups for the database.
Toolbar
The toolbar at the top of the Groups tab provides a set of actions for maintaining user groups:
Item
Add

Icon

Description
Opens the Add group dialog, where you can create a new
group in the database. To create a new group, enter a name
for the new group and a brief description.
Important: Group and user names have to be unique
within the database.
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Item

Icon

Description

Edit

Opens the General tab for the group currently selected in the
group table, where you can modify, for example, the avatar
and description of this group.

Remove

Opens a dialog where you can delete the currently selected
group from the database.

Filter

Displays only those groups in the table whose name or
description contains the character sequence you enter in the
text box.

Table
The table below the toolbar displays details on the currently available user groups.
Item

Description

Avatar

Displays the avatars of the groups listed in the Group
column.

Group

Lists the names of all groups set up in the database or, if you
set a filter, of the groups that match the filter.

Description

Provides brief descriptions of the groups listed in the Group
column.

4.1.2.2 General tab
Details section
The following items are available:
Item

Description

Change

Opens a dialog, where you can select a JPEG or PNG image
to be used as the avatar of the currently selected group.

Name

Displays the name of the currently selected group.

Description

Allows you to edit the description of the currently selected
group.

Expiry date

Sets an expiration date for the currently selected group.

Group is disabled

Disables the currently selected group.
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Item

Description

Translate

Opens the Translate dialog, where you can provide
translations of the description. Please consult the Defining
translations for account-related descriptions section for more
information.

Members section
The following items are available:
Item

Description

Add

Opens the Add members dialog, which allows you to select
one or several PLA 3.0 users from a list and assign them to
the currently selected group.

Remove

Removes the currently selected user from the group.

Filter

Modifies the Members table displayed to only include the
groups whose description contains the character sequence
you enter in the text box.

Avatar

Displays the avatars of the users listed in the Name column.

Name

Lists the login and display names of all PLA 3.0 users who are
members of the group or, if you set a filter, of the members
who match the filter.

Description

Provides brief descriptions of the members listed in the
Name column.

4.1.2.3 Roles tab
The following items are available:
Item

Description

Add

Opens the Add global roles dialog, where you can select one
or several global roles from a list and assign them to the
currently selected group.

Remove

Removes the currently selected global role from the group.

Role

Lists the names of all global roles assigned to the group.
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Item

Description

Description

Provides brief descriptions of the global roles listed in the
Role column.

4.1.3 Directory service configuration
Use secure LDAP (LDAPS) directory services, such as Microsoft Active Directory Domain Services,
to authenticate PLA 3.0 users. You map your PLA 3.0 groups, which have PLA 3.0 roles assigned,
to user groups set up on a directory server. You cannot directly assign directory users to PLA 3.0
groups.
Navigation: System > Directory service
Note: When you use directory services to authenticate users, PLA 3.0 has read-only access to
the directory server to read information on users and their assignments to groups. If users need
to change their password, for example, this has to be done by other means.
The Directory service configuration wizard, a series of five dialogs, allows you to set up the
connection to the directory server and map PLA 3.0 groups to directory groups.

4.1.3.1 Step 1: Access directory server
Enter the settings required to establish a connection to the directory server.
General section
The following items are available:
Item

Description

Use directory service

Enables directory services.
Tip: When you disable directory services, PLA 3.0 still
keeps the settings you make in this dialog.

Directory server section
The following items are available:
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Item

Description

Host

Enter the name or IPv4 address of the directory server host.
Note: PLA 3.0 only supports encrypted connections
(SSL) to directory servers. Please make sure the server uses
appropriate encryption.
Example: 192.168.1.210

Port

Enter the number of the port to be used.
Example: 636

Directory type

Select the directory type from the drop-down list.
The following options are available.
▪ Active Directory
▪ Generic
Tip: Use the Active Directory option if you use Microsoft
Active Directory or Active Directory Domain Services. In all
other cases, use the Generic option.

Search account section
The following items are available:
Item

Description

User ID (Bind DN)

Enter the ID of the user to be employed for the search
account.
Note: PLA 3.0 needs the Search account to access
information required for user authentication. We recommend
to employ a user account specifically designated for this
purpose.
Example: cn=ldapsearch,dc=openldap,dc=int

Password

Enter the password of the search account.
Tip: For the search account, we recommend to employ a
user account whose password does not expire.
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4.1.3.2 Step 2: Review and accept the SSL certificate
PLA 3.0 only supports encrypted connections (SSL) to directory servers. Review and accept the
required SSL certificate.
Certificate check
The following items are available:
Item

Description

Automatically trust certificate

Automatically trust the issued certificate.

Verify certificate manually

Manually affirm that you trust the certificate.

Certificate issued to
Lists information on the entity to which the certificate has been issued.
The following items are available:
Item

Description

The certificate is trusted.

Displays the following command options:
▪ Show certificate
▪ Remove certificate

The certificate will not be
trusted.

Displays the following command options:
▪ Technical details
▪ Show certificate
▪ Trust certificate

Show certificate

Opens the Certificate viewer dialog that displays information
on the certificate.

Remove certificate

Deletes the certificate information, which the directory server
provided, from the database.

Technical details

Displays a pop-up window that provides detailed information
on why the certificate is not trusted.

Trust certificate

Allows you to affirm that you trust the certificate.

Certificate viewer
Displays information on the certificate.
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Item

Description

General tab

Provides the following information on the certificate:
▪ Issued to
▪ Issued by
▪ Validity: Issue and expiration date of the certificate
▪ Fingerprints

Details tab

Provides the following information on the certificate:
▪ Certificate hierarchy
▪ Certificate details
▪ Field raw values

4.1.3.3 Step 3: Configure directory classes and attributes
Directory services require configuration of various directory classes and attributes. This step of
the Directory service configuration wizard lists settings for review and allows you to confirm that
they match the settings of your directory server.
Note: PLA 3.0 only displays this dialog if you select the Generic directory type in step 1. The
Directory service configuration wizard for Active Directory skips this page.
The following items are available:
Item

Description

Class/ attribute type column

Lists both class and attribute types.

Class/ attribute value column

Displays the values of the class and attribute types listed.

Reset to default values

Resets all values displayed to their default.

Examples of valid entries
The following table provides an example of valid entries.
Section

Example types

Example values

Class type

Group class

groupOfNames

User class

inetOrgPerson

Group membership attribute

member

User icon attribute

jpegPhoto

Attribute type
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Section

Example types

Example values

User ID attribute

uid

User name attribute

sn

User display name attribute

displayName

User department attribute

departmentNumber

4.1.3.4 Step 4: Select the search base
Select the directory subtree to be searched to authenticate PLA 3.0 users.
Settings
The following items are available:
Item

Description

Search base

Click ... to open a dialog where you can navigate to and
select the directory tree or subtree that contains the
configuration and is to be searched for users.
Note: Please make sure the directory tree or subtree you
select contains both the Groups and Users.

4.1.3.5 Step 5: Map PLA 3.0 groups to your directory groups
Map your PLA 3.0 groups to user groups set up on the directory server.
The following items are available:
Item

Description

PLA group

Lists the names of all PLA 3.0 groups set up in this database.
Tip: You do not have to map all PLA 3.0 groups listed.

Directory group

Displays the names of the directory groups to which the PLA
3.0 groups are mapped.

Assign

Opens a dialog where you can navigate to and select the
directory group to which you want to map the PLA 3.0 group
currently selected in the group table.

Unassign

Deletes the mapping currently selected in the group table.
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Example of valid entries
The following table provides an example of valid entries.
Example PLA 3.0 groups

Example directory groups

Functional administrators

Group3

Inspectors

<not assigned>

Power users

Group2

System administrators

Group1

Users

<not assigned>

4.1.4 Users
If you do not have access to LDAP directory services on your network, you can set up user
accounts directly in PLA 3.0.
Navigation: System > Account management > Users
▪ Select the top entry of the Users list on the left side of the Account management tab to
display the Users tab on the right side, where you create, modify, and delete users.
▪ Expand the Users list and select one of the users listed to display the General tab and the
Roles and groups tab where you can modify the settings of this user, assign her global roles,
and assign her to user groups.
Tip: When you create a new database in PLA 3.0, one predefined user, named
"Administrator," is included and available from the Account management tab. In the default
setup, this user is needed to maintain the database. Due to its membership in the System
administrators group, it has the System administrator global role assigned, which includes the
required Manage accounts task permission.

4.1.4.1 Users tab
Create, modify, and delete users.
Toolbar
The toolbar at the top of the Users tab provides a set of actions for maintaining users:
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Item

Icon

Add

Description
Opens the Add a new user dialog, where you can create a
new user in the database.
The dialog provides the following controls:
▪ Login name: Enter a login name for the new user.
Note: Group and user names have to be unique within
the database.
▪ New password, Confirm password: Enter a password for
the new user.
Tip: Please consult the Database policies section for
more information on passwords.
▪ Password has to be changed at next login: Locks the user
account for the current password. When the user tries to
log in, a pop-up window prompts the user to change her
password.

Edit

Opens the General tab for the user currently selected in the
user table, where you can modify this user.

Remove

Opens a dialog where you can delete the currently selected
user from the database.

free text
filter

none

Displays only the users whose name or description contains
the character sequence you enter in the text box.

Table
The table below the toolbar displays details on the currently available users.
Item

Description

Name

Lists the login names of all users set up in the database or, if
you set a filter, of the users that match the filter.

Description

Provides brief descriptions of the users listed in the Name
column.
Tip: To change the description of a user, select it in the
table and click Edit, which displays the General tab for this
user.
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4.1.4.2 General tab
Modify the settings of the currently selected user.
Details section
The following items are available:
Item

Description

Change

Opens a dialog where you can select a JPEG or PNG image to
be used as the avatar of the currently selected user.

Login name

Displays the login name of the currently selected user.

First name, Last name,
Description, Department,
Telephone number

Allow you to edit information on the currently selected user.

Display name

Allows you to edit the display name of the currently selected
user. In most contexts, PLA 3.0 substitutes the display name
for the login name. The default value of the display name is
the login name of the user.
Note: The display name does not have to be unique. The
audit trail provides the login names rather than the display
names of users to guarantee traceability of changes to a
particular user account.

E-mail

Allows you to edit the e-mail address of the currently
selected user.

Expiry date

Sets an expiration date for the currently selected user.

Unlock now

Unlocks the currently selected user account.
This button is only enabled if the user has been locked due to
login failures.
Tip: Please consult the Database policies section for more
information on passwords.

Password has to be changed
at next login

Locks the user account for the current password. When the
user tries to log in, a pop-up window prompts the user to
change her password.
Tip: Do not use this feature to enforce new password
policies. At every login, PLA 3.0 automatically checks whether
passwords are consistent with password policies.
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Item

Description

Account is disabled

Disables the currently selected user account. When you
disable an account, the user can no longer log into the
database. And the user name is no longer listed in the Select
user dialog of the login screen.

Set password

Opens a dialog that allows you to change the password of
the currently selected user.
Tip: Please consult the Database policies section for more
information on passwords.

Reset password

Opens a dialog where you can reset the password of the
currently selected user. If you confirm the dialog, PLA 3.0
opens your default e-mail application and creates an email to the user that contains a new, randomly generated
password. You have to send the e-mail manually. When user
try to log in, a pop-up window prompts them to change their
password.
This button is only enabled if you or the user has entered an
e-mail address on this tab.

Translate

Opens the Translate dialog, where you can provide
translations of the description. Please consult the Defining
translations for account-related descriptions section for more
information.

4.1.4.3 Roles and groups tab
Assign global roles to the currently selected user, and assign her to user groups.
Global roles section
The following items are available:
Item

Icon

Description

Add

Opens the Add global roles dialog, where you can select one
or several global roles from a list and assign them to the
currently selected user.

Remove

Removes the currently selected global role from the user.

Role

none

Lists the names of all global roles assigned to the user.
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Item

Icon

Description

Description

none

Provides brief descriptions of the global roles listed in the
Role column.

Groups section
The following items are available:
Item

Icon

Description

Add

Opens the Add groups dialog, where you can select one
or several groups from a list and assign the user to these
groups.

Remove

Removes the user from the currently selected group.

Group

none

Lists the names of all groups to which the user is currently
assigned.

Description

none

Provides brief descriptions of the groups listed in the Group
column.

4.2 Security contexts and document roles
Set up document roles and assign them to users and groups to define security contexts. You
then apply these security contexts to folders to control who can perform particular document
tasks, such as editing documents or applying electronic signatures, in these folders or folder
trees.
Use the following PLA 3.0 features to set up document roles and define security contexts:
Feature

Description

Document roles

Set up document roles as a preliminary step in defining
the security contexts you need for the database. Combine
document tasks into document roles to control who can
perform which tasks on documents stored in particular
folders or folder trees.

Security contexts

Assign document roles to PLA 3.0 users and groups to define
the security contexts you need to control who can perform
which tasks on documents stored in particular folders or
folder trees.
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4.2.1 Document roles
Set up document roles as a preliminary step in defining the security contexts you need for the
database. Combine document tasks into document roles to control who can perform which tasks
on documents stored in particular folders or folder trees.
Navigation: System > Account management > Document roles
▪ Select the top entry of the Document roles list on the left side of the Account management
tab to display the Roles tab on the right side, where you can create, modify, and delete
document roles for the database.
▪ Expand the Document roles list and select one of the document roles listed to display the
General tab on the right side, where you can assign and remove task permissions for this
particular document role.
PLA 3.0 even allows you to customize the individual document task permissions you assign to
document roles. You can impose restrictions that limit the scope of individual document tasks to
particular document types, document modes, and document signature statuses.
Tip: When you create a new database in PLA 3.0, predefined document roles are included
and available from the Account management tab. They are intended as examples to help you set
up the document roles you require.

4.2.1.1 Roles tab
Create, modify, and delete document roles for the database.
Toolbar
The toolbar at the top of the Roles tab provides a set of actions for maintaining document roles:
Item
Add

Icon

Description
Opens the Add document role dialog, where you can create
a new document role in the database. To create a new
document role, enter a name for the new document role and
a brief description.
Important: The names of global roles and document
roles have to be unique within the database.

Edit

Opens the General tab for the document role currently
selected in the role table, where you can modify this
document role.

Remove

Opens a dialog where you can delete the currently selected
document role from the database.
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Item

Icon

Description

free text
filter

none

Displays only the document roles in the table whose name
contains the character sequence you enter in the text box.

Table
The table below the toolbar displays details on the currently available document roles.
Item

Description

Name

Lists the names of all document roles set up in the database
or, if you set a filter, of the document roles that match the
filter.

Description

Provides brief descriptions of the document roles listed in the
Name column.

4.2.1.2 General tab
Details section
The following items are available:
Item

Description

Name

Displays the name of the currently selected document role.

Description

Allows you to edit the description of the currently selected
document role.

Translate

Opens the Translate dialog, where you can provide
translations of the description. Please consult the Defining
translations for account-related descriptions section for more
information.

Task permissions table
The following items are available:
Item

Description

Add

Opens the Add task permission dialog, where you can select
a single task from a list and assign it to the currently selected
document role.
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Item

Description

Remove

Removes the currently selected task from the document role.

Edit

Opens the Restrict task permission dialog for the task
currently selected in the Task permissions table.

Task

none

Lists the names of all tasks assigned to the currently selected
document role.

Description

none

Provides brief descriptions of the tasks listed in the Task
column.

Restrictions

none

Advises of current restrictions imposed on individual task
permissions.
The column indicates the areas where restrictions apply:
▪ Permitted document types
▪ Permitted document modes
▪ Permitted document signature states
Please consult the Restrict task permission dialog for more
information.

Restrict task permission dialog
Use this dialog to impose restrictions that limit the scope of the currently selected document
task permission. To open the dialog for a task permission, select the permission in the Task
permissions table and click Edit.
Tip: When you change the settings of a task permission, your changes only apply to the
currently selected document role rather than all document roles that have the task.
The following items are available:
Item

Description

Task

Displays the name of the task to which the settings of the
dialog apply.

Description

Displays the description of the task.

Permitted document types

Lists all document types activated for the database. By
default, all document types are included.
Clear the checkboxes of the document types you want to
exclude from this task permission.
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Item

Description

Permitted document modes

Lists all document modes available in PLA 3.0. By default, all
document modes are included.
Clear the checkboxes of the document modes you want to
exclude from this task permission.

Permitted document
signature states:

Lists all document signature states available in PLA 3.0. By
default, all document signature states are included.
Clear the checkboxes of the document signature states you
want to exclude from this task permission.

4.2.1.3 Document tasks
The following table explains the tasks available for document roles.
Item

Description

Create new documents

▪ Create new documents, templates, and folders in the
database.
▪ Import documents into the database.
▪ Generate documents from templates available in the
database.
▪ Create new PQ definitions.
▪ Execute OQ and PQ.

Read documents

▪ View the name and other properties of documents and
folders that are available for display in the Navigator.
▪ Open and view documents in the editor (read-only mode).

Edit documents

Open and modify documents in the editor.

Remove documents

Delete documents and folders from the database.

Move documents

Move documents to other locations within the database.
Note: This task also requires permission to Create new
documents in the target folder.

Copy documents

Copy documents and folders to other locations within the
database.
Note: This task also requires permission to Create new
documents in the target folder.
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Item

Description

Export documents

Export documents from the database.
Tip: Exported PLA 3.0 document packages have the
.edpdpx file extension.

Change document and folder
key

Change the identification key of documents and folders.
Note: The Deny change document or folder key option in
the Database policies overrides this permission for the entire
database (System > Database policies > Advanced).
Tip: The extent to which users are free to decide on the
form of new keys depends on the Document key format
settings in the Folder properties (File > Folder properties >
Document key format).

Read folder properties

Open the Folder properties dialog on a folder to view its
settings (File > Folder properties).

Edit folder properties

Open the Folder properties dialog on a folder to modify its
settings (File > Folder properties).

Edit documents with
elevated permissions

Open documents generated from a template in the mode
required to edit the values and field protections set by the
template (File > Open selected document(s) with elevated
permissions).

Change security context

Open the Change security context dialog on a folder to select
a different security context for this folder (File > Advanced >
Security context).

Confirm electronic signatures

Open the Signatures dialog to apply one or more electronic
signatures to documents that have been signed already.
Note: This task also requires permission to open the
documents to be signed.

Apply electronic signatures

Open the Signatures dialog to apply one or more electronic
signatures to documents irrespective of whether they have
been signed already.
Note: This task also requires permission to open the
documents to be signed.
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Item

Description

Remove own electronic
signatures

Open the Signatures dialog to delete signatures that have
been applied by the current user.
Note: This task also requires permission to open the
documents whose signatures are to be deleted.
Note: The Deny signature removal option in the Database
policies overrides this permission for the entire database
(System > Database policies > Signatures).

Remove all electronic
signatures

Open the Signatures dialog to delete signatures that have
been applied by the current or other users.
Note: This task also requires permission to open the
documents whose signatures are to be deleted.
Note: The Deny signature removal option in the Database
policies overrides this permission for the entire database
(System > Database policies > Signatures).

Create document
attachments

Add new attachments to a document.

Edit document attachments

Edit existing document attachments.

Read document attachments

View the attachments of a document.

Read document attachments
content

View the contents of a document attachment.

Remove document
attachments

Remove existing attachments from a document.

4.2.2 Security contexts
Assign document roles to PLA 3.0 users and groups to define the security contexts you need to
control who can perform which tasks on documents stored in particular folders or folder trees.
Navigation: System > Account management > Security contexts
To define security contexts, you simply assign document roles to subjects (users or groups).
Security contexts consist of one or more such role-to-subject assignments.
Note: Every folder in the database has to be assigned to a security context. Folders inherit
the security context of their parent folder unless you explicitly assign them to a different security
context.
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▪ Select the top entry of the Security contexts list on the left side of the Account management
tab to display the Security contexts tab on the right side, where you create, modify, and
delete security contexts for the database.
▪ Expand the Security contexts list and select one of the security contexts listed to display the
General tab and the Folder tab on the right side, where you can modify the settings of this
security context, create and add new role-to-subject assignments, and view a list of all folders
that belong to this security context..
Tip: When you create a new database in PLA 3.0, one predefined security context, named
"Root Security Context," is included and available from the Account management tab. In the
default setup, this security context is needed because the Root folder is assigned to it and all
other folders are assigned to it by inheritance.

4.2.2.1 Security contexts tab
Create, modify, and delete security contexts for the database.
Toolbar
The toolbar at the top of the Security contexts tab provides a set of actions for maintaining
security contexts:
Item

Icon

Add

Description
Opens the Add security context dialog, where you can create
a new security context in the database. To create a new
security context, enter a name for the new security context.
and a brief description.
Important: The names of security contexts have to be
unique within the database.

Edit

Opens the General tab for the security context currently
selected in the security context table, where you can modify
this security context.

Remove

Opens a dialog where you can delete the currently selected
security context from the database.

free text
filter

none

Displays only the security contexts in the table whose name
or description contains the character sequence you enter in
the text box.

Table
The table below the toolbar displays details on the currently available security contexts.
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Item

Description

Name

Lists the names of all security contexts set up in the database
or, if you set a filter, of the security contexts that match the
filter.

Description

Provides brief descriptions of the security contexts listed in
the Name column.

4.2.2.2 General tab
Details section
The following items are available:
Item

Description

Name

Displays the name of the currently selected security context.

Description

Allows you to edit the description of the currently selected
security context.

Translate

Opens the Translate dialog, where you can provide
translations of the description. Please consult the Defining
translations for account-related descriptions section for more
information.

Assigned roles table
The following items are available:
Item
Add

Icon

Description
Opens the Add role (security contexts) dialog, where you can
select a single subject (user or group) and a single document
role from a list.
This defines a new role-to-subject assignment, which you can
add to the current security context.

Remove

Deletes the currently selected role-to-subject assignment.

Avatar

Displays the avatars of the subjects (users and groups) listed
in the Subject column.
The icon displayed here is an example.
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Item

Icon

Description

Subject

none

Lists the users (login and display name) and groups (group
name) who have document roles assigned in the current
security context.
Tip: Each role-to-subject assignment is listed in a separate
table row. Subjects who have more than one role assigned
are listed more than once in the table.

Role

none

Provides the names of the document roles assigned to the
users and groups listed in the Subject column.

4.2.2.3 Folders tab
The following table explains the features and controls available in the Security contexts dialog.
Item

Description

Assigned folders/ Path list

Displays the database paths of all folders assigned to the
current security context.
Tip: Use the Change security context dialog to assign
additional folders to the security context and to remove
folders from it (File > Advanced > Security context).

4.3 Permissions of folders, documents, and data elements
Set up permissions to control access to folders, documents, and individual data elements.
Use the following features to apply fine-grained permissions to folders, documents, sections
within documents, and even individual data elements within documents:
Feature

Description

Security contexts

Assign folders to security contexts to control what actions
particular users and groups can perform on documents
stored in particular folders and folder trees.

Folder properties

Set folder properties to restrict the content of particular
folders to particular document types and to documents
generated from particular document templates. Set the
names of folders. Customize the identification key formats of
folders and of the documents and templates they contain.
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Feature

Description

Document templates

Standardize the structure of documents and define initial
values for documents generated from templates. Exercise
fine-grained control over user access to particular sections
and even individual data elements within documents.

4.3.1 Changing the security context
Assign folders to security contexts to control what actions particular users and groups can
perform on documents stored in particular folders and folder trees.

About this task

Every folder in the database has to be assigned to a security context. Folders inherit the security
context of their parent folder unless you explicitly assign them to a different security context.
By default, all folders in PLA 3.0 databases are assigned to the Root security context since they
inherit the Root folder's default assignment to this context.
Important: To assign a folder to a different security context, PLA 3.0 also has to lock all
folders that inherit this change and the documents they contain. Make sure that none of these
folders and documents are locked by other users.

Procedure

To change the security context of a folder:
1. In the Navigator, select the folder for which you want to change the security context.
2. Select File > Advanced > Security context.

Result: The Change security context dialog opens, displaying the unique identification key of
the folder to which the settings apply in the header.

3. Assign a security context to this folder and its sub folders: From the New drop-down list,
select the new security context to which you want to assign the folder and its subfolders.

The name of the old security context to which the folder is currently assigned is displayed in
the Current text box.
Note: Subtrees that are explicitly assigned to a different security context do not inherit
the new assignment.

4.3.2 Folder properties
Set folder properties to restrict the content of particular folders to particular document types
and to documents generated from particular document templates. Set the names of folders.
Customize the identification key formats of folders and of the documents and templates they
contain.
Navigation: File > Folder properties
Select a folder in the Navigator to open its Folder properties dialog.
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This feature is only available if the security context of the folder allows users to perform the
Edit folder properties document task (System > Account management > Document roles >
General).
Note: Folders inherit the properties of their parent folder by default. If you change the
properties of a folder, the changes apply to all subfolders. Changes do not apply to existing
documents in the folder and its subfolders.

4.3.2.1 General tab
General section
The following items are available:
Item

Description

Document key

Displays the unique identification Key of the folder to which
the settings in the dialog apply.

Name

Allows you to edit the name of the folder.

Security section
The following items are available:
Item

Description

Security context

Displays the name of the security context to which the folder
is currently assigned.
Tip: Use the Change security context dialog to assign
the folder to a different security context (File > Advanced >
Security context).

4.3.2.2 Document key format tab
Adapt the formats used to generate identification keys according to your requirements.
To change the current configuration for document, template, and folder keys, click Change
configuration below the table. To reset all key formats defined on this tab to their default, click
Reset configuration.
Changing the format of identification keys is possible under the following conditions:
▪ The Deny change document or folder key option in the Database policies is disabled
(System > Database policies > Advanced).
▪ The security context of the folder allows users to perform the Change document and folder
key document task (System > Account management > Document roles > General).
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Note: If these conditions are not met, the corresponding items on this tab are not available.
Default keys section
Displays the formats used to generate unique identification keys for new documents, templates,
and folders added to the database.
The following items are available:
Item

Description

Change

Open the Document key format, Template key format,
and Folder key format dialogs where you can modify the
formats used to generate unique identification keys for new
documents, templates, and folders.

Document type specific keys section
The following items are available:
Item

Icon

Description

Add

Opens the Add specific key format dialog, where you
can select a document type from a drop-down list and
define both a document and a template key format for this
particular document type.

Remove

Deletes the document and the template key format of the
document type currently selected in the table.

Edit

Opens the Edit default key format dialog, where you can
modify both the document and the template key format of
the document type currently selected in the table.

Document
type

none

Lists the document types for which document and template
key formats are defined for this folder.

Document
key

none

Display the document key formats defined for the document
types listed in the table.

Template key

none

Displays the template key formats defined for the document
types listed in the table.

Enable
custom
document
keys

none

Permits changes to the counters that are part of document,
template, and folder keys. Makes the Change document
key dialog available to users (File > Advanced > Change
document key).
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4.3.2.3 Document restrictions tab
To change the current configuration for document restrictions, click Change configuration
below the table. To reset restrictions defined on this tab to their default, click Reset
configuration.
Note: The settings in the Document-type specific templates section override the settings in
the Templates section.
Templates section
The following items are available:
Item

Description

Restrict available templates

Specifies the templates available to users to generate
documents in the current folder. To specify the templates,
you store them in another folder which you designate for this
purpose.

Template folder

Allows you to enter the path to the folder you want to
designate as template folder. The template folder is to hold
all templates you want to make available to users to generate
documents in the current folder.

Change

Opens the Select folder dialog, where you can navigate to
and select the folder you want to designate as template
folder. The template folder is to hold all templates you want
to make available to users to generate documents in the
current folder.

New documents must be
created using templates

Restricts how users can create new documents in the current
folder. Hides all entries that are not templates in the Create a
new document dialog for the current folder (File > New).

Document type-specific templates
The following items are available:
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Item

Icon

Add

Description
Opens the Configure document type dialog, where you can
select a document type from a drop-down list and assign it
to the current folder.
If the database has templates for the document type you
select, the dialog also allows you to select and enable a
mandatory template. This hides all entries that are not
templates for the document type when users open the Create
a new document dialog for the current folder (File > New).
Tip: For each document type, you can only assign one
mandatory template to be used in the current folder. If you
need several templates for a document type, put them in
a single folder and enable both options in the Templates
section of this tab.

Remove

Removes the document type currently selected in the table
from the current folder.

Edit

Opens the Configure document type dialog for the
document type currently selected in the table, where you can
select and enable a mandatory template for the document
type. This hides all entries that are not templates for the type
when users open the Create a new document dialog for the
current folder (File > New).
Tip: For each document type, you can only assign one
mandatory template to be used in the current folder. If you
need several templates for a document type, put them in
a single folder and enable both options in the Templates
section of this tab.

Document
type

none

Lists the document types of which users can save documents
to the current folder.

Template

none

Displays the name of any mandatory templates assigned to
the document types for the current folder.

Template key

none

Display the unique identification key of any mandatory
templates assigned to the document types for the current
folder.
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Item

Icon

Description

Only
documents
of the listed
document
types can be
saved to this
folder

none

Specifies the document types that users can save to the
current folder. To specify the document types, you add them
to the table.

4.3.3 Document templates
Standardize the structure of documents and define initial values for documents generated
from templates. Exercise fine-grained control over user access to particular sections and even
individual data elements within documents.
Navigation:
File > Open selected document(s) > Content editor > Protection settings pane
File > New > Content editor > Protection settings pane
About document templates
Open a template or create a new template to display the Protection settings pane at the bottom
of the Content editor.
Document templates simplify tasks, standardize processes, and improve data security. Use them
to define document structures that are frequently needed, for example, to match the setup of an
assay that is frequently run. Document templates also allow you to define initial values to be set
in documents. And they enable you to exercise very fine-grained control over who can view and
edit document sections and even individual data elements within documents.
PLA 3.0 allows you to enforce the use of templates and prevent users from creating documents
that are not generated from templates. To enforce templates, you define Document restrictions
in the Folder properties. Please consult the Folder properties section for more information.
When users work with documents generated from templates, the Open with elevated
permissions command in the File menu enables them to override settings provided by the
template. Users have access to this command if the security context of the document's folder
allows them to perform the Edit documents with elevated permissions document task
(System > Account management > Document roles > General).
When users open templates, the controls of the Protection settings pane are only available
to the extent to which the security context of the template's folder allows them to perform
related document tasks, that is, Read documents and Edit documents (System > Account
management > Document roles > General).
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4.3.3.1 Protection settings pane
The title of the Protection settings pane displays the name of the element currently selected in
the Content editor. The settings displayed in the Protection settings pane apply to this particular
element.
If you want to change the protection settings of another element, you have to first select it in
the Content editor.
Tip: To prevent users from changing observation data, for example, select the Observation
data element in the Content editor and adjust its protection settings according to your needs.
Permissions section
The following items are available:
Item

Description

View element

Shows this element in documents generated from the
template.
Note: If you disable this option, PLA 3.0 hides this
element in documents generated from the template, but still
uses it in calculations and other processes.

Edit value

Allows users to change the value of this element in
documents generated from the template.

Switch element

Applies to elements that belong to a set of options such as
the six regression model types in Quantitative response assay
documents. Displays the current element in a drop-down box
that allows users to switch to another option.
Tip: If you disable this option, PLA 3.0 does not display
the drop-down box and users cannot select an alternative.

Delete element

Makes the Delete command available for this element if the
element is not required by the document type.
Tip: If you disable this option, PLA 3.0 does not display
the Delete command in context menus for this element.

Add child element

Allows users to add subelements to this element.
Tip: Subelements are not available for all element types.
The availability of subelements for a particular element type
also depends on the document type.
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Item

Description

Apply to descendants

Applies the protection settings of the current element to
every subelement of the current element.
Note: This command applies to all subelements
irrespective of whether PLA 3.0 displays them in the Content
editor.

Initial value section
Use the Initial value text box to define the initial value you want to set for the current element in
all documents generated from the template.
Tip: You can use placeholders to define initial values to be set in documents generated from
templates.
To insert a placeholder:
1. Click the Initial value text box and press CTRL + Space to display the placeholder dialog.
Tip: Drag the bottom-right corner to expand the dialog.
2. Double-click the placeholder to insert it into the Initial value text box.
Tip: Single-click placeholders to display brief descriptions.

4.3.3.2 Initial value placeholders
PLA 3.0 provides a set of placeholders you can use to define the initial values you want to set in
documents generated from templates.
currentdate
Inserts the current date when the document is generated from the template.
currentdatetime
Inserts the current date and time when the document is generated from the template.
currenttime
Inserts the current time when the document is generated from the template.
digest:DOCKEY: SECTIONKEY:PROPERTY
Inserts a property of an external document.
Define the following parameters to specify the property to be inserted:
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Parameter

Description

DOCKEY

Specifies the key of the document that contains the property.

SECTIONKEY

Specifies the key of the section that contains the property.
Do not enter a value for this parameter if the property is not
part of a section.
Tip: In Quantitative response assays, for example, the
values of the Name subelements in Standard sample, Test
sample, and Control sample elements serve as Section keys.

PROPERTY

Specifies the key of the property.

elementcounter
Inserts the first number (smallest integer) that has not yet been assigned to this element type
within the document.
Example:
1. Add two Comment elements to a template, and add the Subject subelement to each
Comment element.
2. In the Initial value text box of each of the two Subject subelements, type the word
Instruction, type a space, and insert the elementcounter.
3. Save the template, and generate a document from the template.

Results: The first Comment element has the Subject line 'Instruction 1,' and the second has
the Subject line 'Instruction 2.'

Note: If you delete elements, PLA 3.0 reuses the numbers that had been assigned to them.
Tip: Use the keyedcounter placeholder rather than the elementcounter placeholder if you
want to apply (1) two or more counters to one element type or (2) one counter across two or
more element types within a single document. And use the sequence placeholder to apply a
counter across two or more documents generated from the template.
elementcolor
Applies the first predefined color that has not yet been assigned within the document.
empty
Applies to elements that have values assigned in the template. Omits the values in documents
generated from the template.
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generator
Applies to documents generated by other documents. Inserts the document key of the
document that has generated the current document.
keyedcounter:KEY
Inserts the first number (smallest integer) that has not yet been assigned to this key within the
document.
Define the following parameter:
Parameter

Description

KEY

Specifies the key used to identify elements where the
numbers provided by the counter are to be inserted.

Example:
1. Add three Comment elements to a template, and add the Subject subelement to each
Comment element.
2. In the Initial value text box of two of the Subject subelements, type the word Instruction,
type a space, insert the keyedcounter, and replace 'KEY' with comment_key_inst.
3. In the Initial value text box of the third Subject subelement, type the word Requirement,
type a space, insert the keyedcounter, and replace 'KEY' with comment_key_req.
4. Save the template, and generate a document from the template.

Results: The first Comment element has the Subject line 'Instruction 1,' the second has the
Subject line 'Instruction 2,' and the third has the Subject line 'Requirement 1.'

Note: If you delete elements, PLA 3.0 reuses the numbers that had been assigned to them.
Tip: If you enter additional text—outside the curly braces—in the Initial value fields, this text
also needs to be identical for all elements that are to share a single counter.
Tip: Use the elementcounter placeholder rather than the keyedcounter placeholder if you
want to apply a counter to elements of the same element type within a single document. And
use the sequence placeholder to apply a counter across two or more documents generated
from the template.
sequence:PADDING: PREFIX:SUFFIX
Inserts a string that can serve as a key. The string consists of a prefix, a counter with padding,
and a suffix.
Define the following parameters to specify the string to be inserted:
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Parameter
PADDING

Description
Specifies the minimum number of digits to be used for the
counter. Enter a number (integer) such as "5" if the counter is
to have at least five digits.

PREFIX

Specifies the prefix of the string to be inserted.

SUFFIX

Specifies the suffix of the string to be inserted.

Example:
1. Add a Comment element to a template, and add the Subject subelement to the Comment
element.
2. Insert the sequence placeholder in the Initial value text box of the Subject subelement, and
replace "PADDING" with "5," "PREFIX" with "have_," and "SUFFIX" with "_coffee(s)."
3. Save the template, and generate two documents from the template.
Results:

▪ The first document has the Subject line "have_00001_coffee(s)."
▪ The second document has the Subject line "have_00002_coffee(s)."
Note: If you delete elements, PLA 3.0 reuses the numbers that had been assigned to them.
Tip: Please consult information on the elementcounter and keyedcounter placeholders
provided above if you want to apply separate counters in each document generated from the
template.
userdisplayname
Inserts the Display name of the current user when the document is generated from the template.
userloginname
Inserts the Login name of the current user when the document is generated from the template.

4.4 Defining translations for account-related descriptions
If you define translations in the preferred languages of your users, PLA 3.0 displays the
description in the language preferred by the current user according to the language settings of
the operating systems.
Note: Translating descriptions is possible for most of the settings on the Account
management tab.

Procedure

To define translations:
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1. Click Translate.

Result: The Translate dialog opens, displaying the default language and additional languages
you have added. Expand the node of a language to display items you can translate. Click a
translation to edit the text.

2. To add an additional language, click Add.
3. In the Add language dialog, select a language or locale identifier from a drop-down list
4. To add the language to the table, click OK.
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